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1 Similarity Score によるセンサーグラムの比較 

バイオ医薬品の品質（結合）特性解析に Biacore の kinetics データは様々な場面で使われて

います。たとえば、安定性試験、ロット管理、処方・製造変更時、バイオシミラーや ADC

のリファレンス抗体との同等性比較などです。ところがそのような用途で同等性を評価す

る場合、検体自身が本質的に有する不均一性（heterogeneity）の問題などから、速度定数:ka

および kd 値を算出することや取り扱うことが困難なときがあります。そのような場合にセ

ンサーグラムの形状の相似性を Similarity Score と呼ばれる値として算出して、同等性を評価

することが可能です。 

Similarity Score の算出方法の概要は次の通りです。詳しい評価手順、アルゴリズムは 1-2 か

らをご参照ください。 

1) Standard（標準品：複数回）、Sample（評価するサンプル）の測定 

同一条件でセンサーグラムを取得します。 

 

2) Evaluation Software で Sample Comparison を解析 

① Standard の繰り返し測定結果から、変動幅（Variation window）を設定します。 

Standard の繰り返し測定の平均センサーグラム（Average）を中心として、変動幅（Variation 

Window)を SD 値を用いて設定します。通常、± 1～3 SD（Standard Deviation） に設定しま

す。 
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② Sample のセンサーグラムのプロットについて、Variation Window 内の割合と、Variation 

Window から外れたプロットの Average プロットからの距離を用いたアルゴリズムで、

Similarity Score を算出します。Similarity Score が 100 %に近いほど、Standard のセンサーグ

ラムに形状が近似していると判断します。 

 

 

 

1-1. 相互作用測定メソッド 

Biacore T200 Control Software で、Kinetics/Affinity の Wizard または Method を使用してくださ

い。 

マルチサイクル法、シングルサイクル法のどちらも使用可能です。キャプチャー法も使用

できます。必ず、同じ Standard サンプルについてマルチサイクル法では 1 濃度、シングル
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サイクル法では同一の濃度系列で 2 回以上の繰り返し測定データを取得してください。

Standard、Sample、Control の測定は、同じ条件（流速、結合・解離時間、測定濃度）で実

施してください。 

なお、別々のファイルとして保存した測定データでも、解析時にそれぞれのデータファイ

ルを呼び込んで解析を行うことができます。 

 

 

 

 

 

 

 

 

1-2. 解析方法 

ここでは、FcγRIIIa と各種抗体医薬品の相互作用を例に解析方法をご紹介します。 

 

Biacore T200 Evaluation Software を開きます。 

File → Open から、解析を行うファイルを選択します。 

他のファイルを呼び込む場合には、File → Append Result File をクリックします。 

 

↓ 

追加するファイルを選択して、Open をクリックします。 

以下の確認ウインドウが開きます。OK をクリックします。 
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複数のファイルを呼び込む場合には、上記操作を繰り返します。 

↓ 

呼び込んだ全センサーグラムを確認する場合は、画面左の All sensorgrams をクリックしま

す。 

 

↓ 
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センサーグラムに乱れがないか、非特異的結合が起きていないかなど、センサーグラムを

確認してください。 

↓ 

解析に進むために、ToolbarのSensorgramボタンのSensorgram Comparisonを選択します。 

 

↓ 
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① Name に解析名を入力します。② Cycle Type は、Reference Subtraction（コントロー

ルセルを差し引いたセンサーグラム）を選択します。 

ウインドウ下のテーブルで、解析に使用するセンサーグラムの選択と、Sample Type

（Standard、Sample、Control）の設定を行います。選択した全センサーグラムのリガンド名

が一致していない場合、および Standard サンプルのアナライト名の記載方法が一致してい

ない場合には、解析には進めません。変更を行う場合には、一旦 Cancel を選択して、Tools 

→ Keyword table で変更を行ってください。③ Include の欄にチェックを入れて、解析に

使用するセンサーグラムを選択します。④ Ligand 名および Analyte 名でソートを掛ける場

合には、テーブルの Ligand または Analyte をクリックしてください。 

① 

② 

④ ③ 
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Sample Type で、それぞれのセンサーグラムについて、Standard、Sample、Control の選択

を行います。選択終了後、Next をクリックします。 

↓ 

画面左に 3 つのタブが表示されています。 

Thumbnails：   センサーグラム確認のためのタブ 

Comparison settings：  解析のための comparison setting と parameters 設定タブ 

Results：   結果表示タブ 

 

Thumbnails タブでは、画面左に Sample Type で色分けされたセンサーグラムの Thumbnail が

表示されています。Standard：青、Control：赤、Sample：緑。 

センサーグラムを選択すると、画面右でセンサーグラムの詳細確認と解析に持ち込むカー

ブの選択ができます。 
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画面左の Thumbnails で、解析に持ちこまないサンプルがあれば、該当するセンサーグラム

上で右クリックを選択後、Set Selection To Rejected をクリックしてください。 

 

 

なお、センサーグラムのアナライト添加開始・終了の前後は、添加時のスパイクノイズを

除くために、自動的にデータポイントの削除を行っています。（スパイクノイズが含まれる

と、以降のセンサーグラムの Normalize に大きく影響します。）削除範囲を変更したい場合

は、画面左 Thumbnails タブ上の Tools → Remove Data を選択して、レバーを移動して削

除するレンジを指定して、OK をクリックしてください。同じ設定が、全センサーグラムに

適応されます。 
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↓ 

Comparison settings タブをクリックします。 

画面左のパネルで、評価するセンサーグラムの領域と、解析アルゴリズムを設定します。 

 

① Sensorgram selection 

次の 3 項目から、解析領域を選択できます。 

Association and dissociation：  結合・解離領域 

Association：    結合領域のみ 

Dissociation：    解離領域のみ 

＊ サンプル添加前の、ベースライン領域は解析には含まれません。 

① 
② 
③ 
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② Algorithm for Comparison 

次の 2 項目から、解析のアルゴリズムを選択できます。 

Standard deviation approach： Standard の平均値（Average）と Standard deviation をベー

スにして変動幅の Window を設定するアプローチ。SD 値のデフォルトは 3 に設定されてい

ます。1～20 の範囲で設定できます。 

Max / Min approach： Standard カーブの中央値（Median）、最小値、最大値をベースに変

動幅のWindowを設定するアプローチ。Curve factorのデフォルトは 1に設定されています。

1～10 の範囲で設定できます。 

 

③ Normalize 

解析に使用するセンサーグラムについて、Normalize（結合量を 100 合わせ）したセンサー

グラムを使用する場合にチェックを入れます（デフォルトでチェックが入っています）。こ

れにより、標的リガンドの固定化量やキャプチャー量の測定毎の違いを考慮することなく、

センサーグラムの形状比較が可能となります。チェックを外した場合は、上記の違いがセ

ンサーグラム形状に反映された条件で解析を行います。結合量が 5 RU 以下のセンサーグラ

ムは Normalize が行えません。 

 

選択した設定に従って、画面右の Standard センサーグラムの表示が変更します。 

 

＜補足：センサーグラムの部分削除＞ 

センサーグラムの部分削除を行いたい場合には、画面左上の Tools > Remove Data を選択し

ます。 

Remove Data のウインドウで、マウス右クリックして削除範囲をドラックして設定後、

Remove Selection をクリックしてください。全センサーグラムで、設定した領域削除が適応

されます。 
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Association and dissociation、Standard deviation approach（3 SD）に設定した場合 

 

Curve plot の表示 

赤色： Standard のオリジナルセンサーグラム。（通常、複数。） 

黒色： Standard センサーグラムを平均した reference standard センサーグラム。 

青色： Variation Window。平均したセンサーグラム（黒色）± 指定した SD の Window（偏

差の許容限界）。 

 

Deviation plot の表示 

X 軸： 時間、Y 軸： Deviation に置き換えたプロット。 

青色： Variation Window。指定した SD のプロット（± 3 SD に指定した場合、Y 軸 ＝ ± 3 

SD で固定）。 

赤色： Standard センサーグラムのプロットを平均に対する Deviation で表示。Deviation は

Curve plot 

Deviation plot 
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次の式で算出されます。 

 

Association and dissociation、Max/Min approach (Curve factor ＝ 1 )に設定した場合 

 

 

Curve plot の表示 

赤色： Standard のオリジナルセンサーグラム。（通常、複数。） 

黒色： Standard センサーグラムの任意の時間における各プロットの中央値を採用した

reference standard センサーグラム。 

青色： Variation Window。Standard センサーグラムの、任意の時間における各プロットの

最大値（Maximum）、最小値（Minimum）をプロット。 

 

Deviation plot の表示 

X 軸： 時間、Y 軸： Deviation に置き換えたプロット。 

青色： Variation Window。Window limit の上限値、および下限値は次の式で算出されます。 

ここで、Tolerance は、(Min response － Median)で定義されています。このため、Deviation plot

Curve plot 

Deviation plot 
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の Lower window limit は直線で表示されます。 

 

 

赤色： Standard センサーグラムの Deviation。次の式で算出されます。 

 

 

↓ 

解析アルゴリズムを設定後、Result タブをクリックして、結果を確認します。 

 

画面左の Bar graph では、Similarity score の棒グラフと、サマリーテーブルが表示されます。

選択したサンプルの詳細は、画面右で確認できます。 

1 つの Sample について同じリガンド表面で複数回測定している場合には、画面左の Bar 

graph と table には平均値が表示されます。個々の結果は、画面右下の Result details で確認

できます。 
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Association and dissociation、Standard deviation approach（3 SD）に設定した場合 

 

画面右上には、選択した Sample の Curve plot を表示します。 

赤色： 選択した Sample のセンサーグラム。 

黒色： Standard の平均センサーグラム。 

青色： 平均センサーグラム ± 指定した SD のセンサーグラム。 

 

画面右中央には、選択した Sample の Deviation plot を表示します。 

赤色： Sample の Deviation プロット。 

青色： Variation Window。± 指定した SD。 

 

画面右下のテーブルでは、解析結果の詳細を確認できます。（Max/Min approach も同様です。） 

 

 

① Similarity Rating of Points Outside Range 

Variation Window から外れた全てのプロットについて、次の式から算出した Similarity Rating。

Variation Window 内や Window の線上のプロットは、Similarity rating に関与しません。この

値は、0～1 の範囲をとり、Window から外れている距離の程度を示す値です。この値は、下

① ② 
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記②で記述される Similarity Score 算出にも使われます。 

 

Standard distance： window limit の平均値、または中央値からの距離（下図の A に相当）。 

Sample distance： 各 sample の平均値、または中央値からの距離（下図の B に相当）。 

 

② Similarity Score 

Similarity Score は、Variation Window 内のプロットの割合と、Window 外のポイントの割合と

window limit からの距離（Similarity Rating）を考慮して算出します。計算式は次の通りです。

0～100 %の値を取ります。 

 

↓ 

画面左上の Scatter Graph タブをクリックします。 

各サンプルについて、X 軸： Points Inside Range （%）、Y 軸： Similarity Score （%）の

プロットを確認できます。 

A: 

B: 

Average Plus SD 

Average Minus 

SD 
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このプロットでは、Similarity Score と一緒に、Variation Window 内側のポイント割合を確認

することで、偏差の違いについて、多くの小さな偏差（A）が含まれるか、それとも、いく

つかの大きな偏差（B：スパイクの混入や突発的な乱れなど）が含まれるかを確認すること

ができます。以下、イラストを参照。 

 

↓ 

なお、画面左下のテーブル右端の Comment欄に任意のコメントを入力することができます。

空欄をダブルクリックして、コメントを入力してください。 

A: 

B: 
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↓ 

解析が終了したら、ウインドウ右下の Finish をクリックしてください。 

解析結果は、Evaluation Explorer パネルの、Sensorgram フォルダに追加されます。 
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2 検量線不要の濃度測定 

CFCA （Calibration Free Concentration Analysis） 

検量線を必要としない濃度測定法（CFCA ; Calibration Free Concentration Analysis） は、アナ

ライトの拡散特性とセンサーグラムの結合領域初期における結合速度（初期結合速度）を

利用して、カーブフィッティングにより、結合活性を有するアナライト分子の絶対濃度を

算出する方法です。適した標準分子がない場合や、標準サンプルの結合活性濃度を確認し

たい場合に有効です。さらに、厳密な速度定数と親和定数を求める目的においても、CFCA

により絶対的な結合活性濃度を求めることは有効です。 

 

 

 

 

 

 

 

 

CFCA では、リガンドをできるだけ多く固定化（例：分子量 150 kDa で 5000 RU 以上）し、

マストランスポートリミテーション条件下で測定を実施します。固定化量が多い表面にお

いて、初期結合速度は、アナライトの分子量（Mw）、マストランスポート係数（km）、アナ

ライト濃度（Conc）で決定されます。このため、上記の初期結合速度（d[R] / dt）の関数を

利用してサンプル中のアナライト濃度を算出することができます。 

測定は、アナライトを最低 2 流速（5 および 100 μl/min を推奨）で添加して、センサーグ

ラムから初期結合速度を求めます。マストランスポート係数（km）は、拡散係数（D）、流

速、フローセル容積から計算できます。得られた 2 流速でのセンサーグラムを、1 : 1 結合

モデルで Kinetics 解析し、アナライトの分子量（Mw）、km値を定数とし、アナライト濃度を

パラメータとしてカーブフィッティングすることで濃度を算出します。なお、アナライト

が抗体（Bivalent Analyte）であっても、マストランスポートリミテーション条件下で、カー

ブフィッティングが良好であれば、CFCA を実施することができます。 

 

参考文献： 

Christensen, Anal. Biochemistry （1997）249, p.153 

Sigmundsson, K., et. Al., Biochemistry （2002） 41, p.8263 

 

 

 

MW ：分子量（Da） 

km  ：マストランスポート係数 

= f （M
w

, km
, Conc） 

dt 
___ d[R] 

d[R] / dt 

5 μl/min 

100 μl/min 



 2 検量線不要の濃度測定 17 

 

Biacore T200 v3 

日本語取扱説明書～追補版～ 

 

 

CFCA を実施するための至適条件 

① アナライト 分子量 ≧ 5,000Da 

② 結合速度定数（ka） 107 ＞ ka ＞ 5 X 104 M-1s-1 

③ 固定化量  できるだけ多く固定します。 

 （分子量 150kDa では、5,000RU 以上は必要。） 

④ アナライト濃度         CFCAで良好な結果が得られる濃度レンジは、0.5～50 nM で

す。測定に用いるサンプル濃度は、1 μg/ml 程度が至適です。吸

光度（280 nm）による総タンパク質濃度を基準として調製しま

す。濃度が不明な場合には、10 倍希釈系列で 4 濃度以上調製し

てください。 

⑤ 流速 5 μl/min および 100 μl/min を推奨します。 

⑥ サンプルの性状 拡散係数や分子量が大きく異なる分子の混合溶液の場合には

CFCA は実施できません。 

 例）アナライトが IgG のポリクローナル抗体の場合には CFCA は

可能ですが、アナライトが IgGと IgMの混合溶液の場合にはCFCA

は実施できません。 

⑦ リファレンスセル リファレンスセルも設定し、リファレンスセルを差し引いたセ

ンサーグラムを利用して CFCA を実施します。 

⑧ 非特異的吸着 非特異的吸着が起きている場合に正確な濃度が算出できません。 

 

補足 2-1. マストランスポート、マストランスポートリミテーションとは 

マストランスポートとは、フローセルを流れる溶液中からセンサーチップ表面への、アナ

ライトの拡散現象を表します。アナライトのセンサーチップ表面への拡散（供給）速度は、

次式で求められます。 

アナライトの拡散速度（mol/m2s）＝アナライト濃度 × マストランスポート係数（km） 

 

D ：拡散係数（m2/s） f  ：測定流速（m3/s） h：フローセルの高さ

（m）  w ：フローセルの幅（m） l ：フローセルの長さ（m） 

なお、アナライトの拡散速度よりも、センサーチップ表面のリガンドとの結合速度が速い

場合、マストランスポートが結合速度を制限するため、マストランスポートリミテーショ

ンが起きているといえます。リガンドの固定化量が多い場合には、マストランスポートリ

ミテーションが起こりやすいです。 

km = 0.98 × √  0.3 × h2 × w × l  

D2 × f 3 
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補足 2-2. 拡散係数の求め方 

CFCA を実施する場合、20 ℃における拡散係数がパラメータとして必要です。 

拡散係数は、分子のサイズと形状によって決定され、次式によって算出できます。 

 

  

 

 

f    ：摩擦率 

    rel  ：20 ℃での水に対するアナライト溶媒の粘性 

   Mw  ：分子量（Da） 

 

なお、以下の方法でも拡散係数を得ることができます。 

① Biacore ウェブの Biacore T200 の拡散係数算出ツール 

② 文献値 

③ 実験的に算出（超遠心分析や光散乱分析など） 

 

Biacore ウェブの Biacore T200 の拡散係数算出ツールによる拡散係数の求め方 

 

次のアドレスにアクセスします。 

http://www.biacore.com /diffusion_calculator  

↓ 

 

 

ユーザー名（User ID）とパスワード（Password）を入力して、LOGIN をクリックします。（事

前に、ユーザー登録が必要です。） 

↓ 

 

D =  
324.3×10-11 

f× rel×Mw
1/3 （m2/s） 
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画面上で、20 ℃における拡散係数を算出します。 

① Molecular weight: 分子量（Da）を入力します。 

② Frictional ratio:  摩擦率。 

○Choose molecular shape にチェックを入れ、 

の▼をクリックして該当の値を

選択します。以下の、3 項目から選択できます。 

・ Globular （1.2）・・・球形のタンパク質（初期設定値） 

例）抗体など 

・ Moderately elongated （1.7）・・・長いタンパク質  

例）フィブロネクチンやプラスミノーゲンなど 

・ Elongated （2.5）・・・硬く、長いタンパク質 

例）フィブリノーゲンやトロポミオシンなど 

 

① 

②

① 

③

① 

④ 
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○ Enter value にチェックを入れると、任意の値を入力できます。 

③ Viscosity relative to water at 20℃ 

 20 ℃における水に対するアナライト溶媒の粘性。 

○ Use standard value （1.00）にチェックを入れると、粘性係数

を 1 とします。（初期設定値） 

○ Enter value にチェックを入れると、任意の値を入力できます。 

 

①～③の設定が終了したら、 をクリックし計算を実行します。④に計算結果

が表示されます。 

 

 

画面下では、任意の温度における拡散係数から、20℃における拡散係数を算出することが

できます。文献や実測によって、20 ℃以外での拡散係数が得られている場合にも利用でき

ます。 
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2-1. プログラムの実行 

テ ン プ レ ー ト の メ ソ ッ ド を 、

https://www.biacore.com/lifesciences/Application_Support/index.htmlの Laboratory Guidelines etc 

→  Methods からダウンロードしてください。ファイル名：BiacoreT200 calibration-free 

concentration analysis2.bme をダウンロードして、C:¥Bia Users¥Methods And Templates に保

存してください。 

Toolbar の Run Method アイコン（  ）または Menu bar の Run → Method をクリック

します。 

↓ 

 

保存したファイルを選択して Open をクリックします。 

↓ 

Method Builder の Main ダイアログが表示されます。Overview 画面にはメソッド全体の設定

項目が表示されます。以下に変更項目について記載します。詳細は Biacore T200 日本語取扱

説明書 –基本操作編-を参照してください。 

↓ 
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General Settings をクリックします。

 

① Data Collection rate 

10 Hz を選択します。 

② Detection 

検出モードを以下の 2 つ（Dual,Multi）から選択します。 

Dual 2-1、4-3 

Multi 2-1,4-3、2-1,3-1,4-1 

③ Sample compartment temperature 

① ② ③ 

④ ⑤ 

⑥ 
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サンプルコンパートメントの温度（4～45 ℃）を設定します。通常は、25 ℃。 

④ Concentration unit 

  アッセイ全体を通して用いる濃度単位を選択します。 

⑤ Buffer settings 

  使用するランニング緩衝液名を入力します。 

⑥ After run 

チェックを入れておくと、全測定が終了した後に、センサー表面の温度が指定し

た温度に自動変更されます。 

設定後、Assay Steps をクリックします。 

↓ 

 

 

① Startup を選択します。 

② 下記のように設定します。 

Number of replicates 

times ベースライン安定化のためのスタートアップの測定回数

を指定します。3 回以上を推奨します。 

↓ 

 

 

① 

② 
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① Sample を選択します。 

② 下記のように設定します。 

Number of replicates 

 times  繰り返し測定回数を選択します。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 
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① Blank を選択します。 

② 下記のように設定します。 

Recurrence  ○Distribute にチェックを入れ、occurrences evenly で 1 を選択。 

   全測定サイクル内で、均等にブランクの測定を実施します。 

Number of replicates 

 times  繰り返し測定回数を選択します。 

↓ 

Cycle Types をクリックします。 

 

Control Sample についても、Blank と同様に設定します。 

 

 

 

 

 

 

 

 

① 

② 
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① Startup をクリックします。アナライト測定前のスタートアップの詳細を設定します。 

② Commands タブの Sample1 をクリックします。 

③ Settings for Sample1 でスタートアップ用サンプル（Buffer）添加の詳細条件を設定します。

測定流速以外は、サンプル添加と同一条件を設定します。 

Type    High performance を選択します。 

contact time   添加時間（s）。基本は 36 秒です。 

Dissociation time   解離時間（s）。基本は 5 秒です。 

Flow rate    流速（μl/min）。基本は 30 μl/min です。 

Flow path   Both を選択します。 

Sample solution   Buffer （ランニング緩衝液） 

 

④ 引き続き、Commands タブの Regeneration1 をクリックします。 

⑤ 再生条件を設定します。 

Regeneration solution  再生溶液名を入力します。 

contact time   添加時間（s） 

Flow rate    流速（μl/min） 

Flow path   Both を選択します。 

 

① 

② 

③ 

④ 

⑤ 
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↓ 

 

① Cycle types currently in Method の Sample をクリックします。 

② Commands タブの Sample1 をクリックします。 

③ Settings for Sample1 でサンプル添加の詳細条件を設定します。 

Type    High performance を選択します。 

contact time   添加時間（s）。基本は 36 秒です。 

Dissociation time   解離時間（s）。基本は 5 秒です。 

Flow rate Is variable に設定されています。実数は、Setup Run の

Variables で入力します。 

Flow path   Both を選択します。 

 

④ 引き続き、Commands タブの Regeneration1 をクリックします。 

⑤ 再生条件を設定します。 

Regeneration solution  再生溶液名を入力します。 

contact time   添加時間（s） 

Flow rate    流速（μl/min） 

Flow path   Both を選択します。 

 

↓ 

① 

② 

③ 

④ 
⑤ 
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Variable Settings を選択します。 

Assay Steps の Sample をクリックします。画面右上で、○ Define some values in Method and 

others at run time. にチェックを入れます。下記の 5 項目については、Setup Run 以降の

Variables で入力します。 

Sample solution  サンプル名 

Flow rate （μl/min） 同一サンプルで、5 μl/min と 100 μl/min の 2 流速を設定します。 

MW（Da）   分子量 

D（20℃）   20 ℃における拡散係数 

Dilution   サンプルの希釈倍率 

 

以下について、画面下で設定します。 

Blank 解析時のキーワードとして利用します。ブランクサンプルか否か

を指定します。サンプルの場合には、”No”または“n”を入力します。 

↓ 
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Assay Steps の Blank をクリックします。画面右上で、○ Define some values in Method and 

others at run time. にチェックを入れます。 

 

Flow rate （μl/min）については、Setup Run 以降で入力します。 

 

画面下で、下記の項目について入力します。 

Sample solution  “Buffer”と入力します。 

MW（Da）   未入力 

D（20℃）   未入力 

Blank ブランクサンプルの場合には、”Yes”または“y”を入力します。 

Dilution   未入力 

 

↓ 

Control Sample は、Sample と同様に設定します。 

↓ 

Verification をクリックします。 

↓ 
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メソッドの設定に不備が無ければ“The Method has been verified and can be used to set up a 

run.”と表示されます。問題が有る場合は該当部分が表示されるので、指示に従って修正し

ます。確認後、Setup Run をクリックします。

↓ 

適切な Flow path を選択し、Next をクリックします。 

↓ 
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Sample をクリックします。下記項目について入力します。 

Sample solution  サンプル名（複数ある場合には名前を変更して追加します） 

Flow rate （μl/min） 同一サンプルで、5 μl/min と 100 μl/min の 2 流速を設定します 

Mw（Da）   分子量 

D（20℃）   20 ℃における拡散係数 

Dilution   サンプルの希釈倍率 

 

↓ 
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引き続き、Blank をクリックします。 

Flow rate （μl/min） Sample と同一の流速を設定します 

Control Sample は、Sample と同様に設定します。 

設定後、Next をクリックします。 

↓ 

測定サイクルリストが表示されます。 
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Next をクリックします。 

↓ 

 

 

 

 

 

 

 

測定を始める前に、Prime および Normalize をおこなう場合にはチェックを入れます。 

入力後、Next をクリックします。 

↓ 

 

右側の表でサンプルの位置とサンプル量（μl）を確認します。表中のサンプルをクリックす

るとそれに対応するラック上の位置が強調表示されます。位置と容量を確認しながらバイ

アルおよびサンプルをラックにセットします。 

補足 2-3. サンプル位置の変更 

サンプル位置は、上記画面に切り替わった時点で自動的に設定されます。あらかじめサン

プル位置が決まっているプレートを使用する場合は、画面左下の Menu → Export Position

を実行し、サンプル位置をタブ区切りのテキストファイルとして保存します。必要事項を

変更した後ファイルを保存し、Menu → Sample Position Import でそのファイルを読み込

むと、サンプル位置が変更されます。
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補足 2-4. 同一バイアルからのサンプリング設定 

サンプル位置は、同一サンプルであっても、添加回数分、分注して配置されるように組ま

れています（例えば同一の Control Sample であっても、R1A1 から R1A12 に 12 バイアルに

分けてセットするように指示されます）。同一サンプルを同バイアルから使用したい場合は

プーリング機能を利用します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu から Automatic Positioning を選択します。 

↓ 

 

 

 

 

 

 

 

 

ここで、すべてのサンプルと試薬に関する配置を設定することができます。 

“Pooling”の項目は、通常、Auto になっています。 

同一バイアルからサンプリングしたいサンプル、試薬の種類について、“Pooling”のプルダウ

ンメニューから Yes を選択し、ダイアログ右下の OK をクリックします。 

 

なお、Automatic Positioning ダイアログでは色やバイアルのサイズの設定もできるので、こ

れらも必要に応じて適宜設定を変更します。
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Eject Rack をクリックして、Rack tray port を開きます。 

↓ 

ラックトレイを奥まで挿入し、OK をクリックします。Eject Rack Tray ダイアログが閉じた

後、Rack Positions ダイアログ右下の Next をクリックします。 

↓ 

 

 

 

 

 

 

 

 

 

 

 

 

基本的な注意事項、測定時間、必要なランニング緩衝液量が表示されます。 

Start をクリックします。 

↓ 

設定したメソッドをテンプレートとして保存するかどうか、メッセージが表示されます。

保存の場合は、Save as で Methods and Templates フォルダまたは Bia Users の各自のフォルダ

に保存します。保存しない場合は、Don’t Save を選択します。 

↓ 

 

 

 

 

 

 

 

 

 

Save in:に測定結果の保存先を設定し、File name にファイル名を入力して、Save すると測定

がスタートします。 

↓ 
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↓ 

終了後、装置は Standby flow 状態になります。 

↓ 

測定データは入力したファイル名で自動保存され、Biacore T200 Evaluation Software が自動的

に起動します。
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補足 2-5. プログラムの緊急停止 

Run → Stop Run をクリックします。 

 

 

 

 

 

ボックス中の Stop Run をクリックします。 

↓ 

 

 

 

 

 

実行中の測定サイクルが終了するまで待機し終了します。 

上記ウインドウが開いている状態で、ただちにプログラムを終了したい場合には、画面の

表示に従い、キーボードの[Ctrl]キーと[Break]キーを同時に押します。 

終了した時点までのデータが Biacore T200 Evaluation Software に移行されます。 

 



38 2 検量線不要の濃度測定  

 

Biacore T200 v3 

日本語取扱説明書～追補版～ 

 

2-3. データ解析 

ウィザードを用いた測定プログラム終了後、Evaluationソフトウェアは自動的に立ち上がり、

取得データは解析に向け移行します。 

 

 

 

 

 

 

 

補足 2-6. サンプル情報の変更 

サンプル濃度および濃度単位、サンプルの名称など入力ミスがあった場合は、解析を実行

する前に、Keyword table で変更します。Tools → Keyword Table をクリックします。 
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Toolbar の をクリックし、 をクリックします。 

↓ 

 

画面左の表に、測定したサンプル情報が表示されます。 

Temp （℃）  測定温度 

Ligand   リガンド名 

Analyte   サンプル名 

Sample Type  サンプルタイプ（Sample、Control Sample） 

File#   呼び出したファイル番号 

Cycle#   測定サイクル番号（低流速-高流速の組み合わせで表示） 

 

解析に持ち込むサンプルは Include にチェックを入れます。 

選択したサンプルの詳細情報は、画面右に表示されます。画面右では以下の情報も表示さ

れます。 

Dilution factor  希釈倍率 

Flow （μl/min）  測定流速 

Blank cycles#  ブランクとして利用しているセンサーグラムのサイクル番号 

   プルダウンで、blank 設定、またはサイクル番号の変更可能 

Initial rate prel（RU/s） 添加開始後 7.5 秒から 12.5 秒幅における初期結合速度 

   （自動計算されます） 

QC ratio prel  QC 比（自動計算されます） 

MW （Da）  サンプル分子量 

D （m2/s）  測定温度における拡散係数（自動計算されます） 



40 2 検量線不要の濃度測定  

 

Biacore T200 v3 

日本語取扱説明書～追補版～ 

 

↓ 

センサーグラム下の、○ Display Sensorgrams for Evaluation を選択すると、ブランクを差

し引いたセンサーグラムを表示します。○ Display Original Sensorgramas を選択すると、

ブランクを差し引いていないセンサーグラムを表示します。 

↓ 

補足 2-7 の選択基準に従って、解析に利用できるセンサーグラムを選択します。 

 

補足 2-7. CFCA に利用するセンサーグラムの選択基準 

CFCA では、マストランスポートリミテーション条件下のセンサーグラムを解析に利用しま

す。 

以下の評価基準を満たすセンサーグラムを解析に利用します。 

① 初期速度（Initial rate （ RU / s ） ） > 0.2～0.3 （ RU / s ） 

かつ、高流速の初期速度が低流速の値よりも高い必要があります。 

   ＜ 0.2～0.3 RU / s では、レスポンスの上昇量が低いため良好な結果が得られません。 

② QC ratio ≧ 0.2 

＜ 0.2 の場合には、マストランスポートリミテーションが十分ではありません。 

 

解析に利用しないセンサーグラムは、Include のチェックを外します。 

↓ 

解析に使用するセンサーグラムの解析レンジの変更、部分削除を実施したい場合には、画

面左上の Tools → Data Ranges を選択します。 
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ウインドウ左のリストで選択したセンサーグラムの重ね書きが、画面右に表示されます。 

 

Y 軸に垂直に 2 本の Fit range(青線)が表示されています。2 本のラインの間が Fitting 領域と

して認識されます。マウスのポインターをライン上に乗せて、左クリックしたままドラッ

クすると位置を変更できます。画面右上の Default Ranges をクリックするとデフォルトの

設定に戻せます。 

 

また、センサーグラム上で削除したい部分がある場合には、センサーグラム上でマウス右

クリックでドラックして範囲を設定して、Remove Selection をクリックします。 

他のサンプルについて、変更を行いたい場合には、画面左のリストでサンプルを選択して、

同様の操作を行います。同時に、同じ設定を複数のサンプルで適応したい場合には、画面

左のリストで該当するサンプルを選択して、センサーグラムを重ね書して、上記操作を行

います。 

Fit range 
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OK をクリックして、ウインドウを閉じます。 

↓ 

画面右下の Fit をクリックします。 

順番に、各サンプルの解析が開始します。 

 

↓ 

 

解析が終了すると、画面左上に Result Summary が表示されます。 

Conc （ M ） 希釈前のサンプルのオリジナル濃度 

（解析で算出された濃度に希釈倍率を掛けた値） 

QC ratio Fit Fitting 後の QC 比 

（解析前の QC ratio prel と異なることがあります。） 



 2 検量線不要の濃度測定 43 

 

Biacore T200 v3 

日本語取扱説明書～追補版～ 

 

Comment 任意のコメントを入力できます 

 

画面左で選択したサンプルのセンサーグラムと詳細情報は、画面右に表示されます。 

Conc （ M ） 希釈前のサンプルのオリジナル濃度 

SE （ Conc ） Conc の標準誤差 

Diluted Conc （ M ） 測定サンプル濃度 

QC ratio Fit Fitting カーブの QC 比 

Initial rate Fit Fitting カーブの初期結合速度 

Chi2 （ RU2 ）  カイ二乗値 

Form Factor フローセル断面積とセンサー表面のフォームファクタ

ー 

 

 

 

 

以下の基準を満たしている場合には、良好な結果と判断できます。 

① カーブフィッティングが良好である。 

フィッティングが良好な場合、カーブフィッティングによって得られた黒色のセンサー

グラムが、測定センサーグラムと一致します。Chi2値が、低流速のセンサーグラムの解

離直前の結合量の 5%以下であれば、フィッティングが良好と判断できます。  

② QC ratio が 0.2 以上である。 

③ SE (conc)（SE: standard error） が解析結果濃度の 20 %以下、または T-value (Conc) が 5



 

 

索引 

 

Biacore T200 v3 

日本語取扱説明書～追補版～ 

 

より小さい。 

④ 確認したいサンプルを選択後、画面右上の Tool → Sensitivity Check を実行して得ら

れた値の優位性が確認できます。（良好なフィッティングが得られなかった際に実施を

推奨します。） 

 

 

オリジナルの Fitting で得られた濃度を± 5 %、10 %、20 %で固定してセンサーグラム

をデータを再解析して、それぞれの Chi2を算出します。X 軸：相対濃度、Y 軸：Chi2の

プロットを作成します。 

プロットを作成するためには、ウインドウ左下の Calculate をクリックします。（同時

に多サンプルの解析はできません。） 
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曲線の勾配が大きいほど、得られた濃度の信頼性が高いと判断します。一方で、曲線の両

側あるいは片側の勾配が小さい場合は信頼性が低いと判断します。 

↓ 

画面左下の Bar chart タグと Trend Plot を確認できます。 

 

Bar chart 

各サンプルの算出されたオリジナル濃度を表示しています。 

 

Trend Plot 
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各サイクルについて希釈後のサンプル濃度を表示しています。赤色： コントロールサン

プル、青色：サンプル。複数の測定ファイルを用いて解析を行っている場合には、破線で

ファイルの切り替えを表示します。コントロールサンプルの測定値の再現性を確認してく

ださい。マウスポインターをプロットに乗せると、詳細情報を表示できます。 

 

Finish をクリックします。 

↓ 

上記解析結果が、Evaluation Explorer 中のフォルダに追加保存されます。 
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Data Collection rate ..................................................................................................................................................... 95, 128 

Desorb ........................................................................................................................................................................................ 154 

Desorb and Sanitize ................................................................................................................................................... 155, 163 

Detection ......................................................................................................................................................... 58, 95, 128, 137 

Dissociation time ............................................................................................................................................ 59, 98, 99, 136 

DMSO ...................................................................................................................................................................... 3, 26, 46, 128 

Dock Chip ............................................................................................................................................................................. 6, 153 
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EDC ........................................................................................................................................................................... 25, 36, 38, 40 

Eject Rack .................................................................................................................................. 11, 30, 38, 49, 64, 106, 148 
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Empty Buffer Tubing .................................................................................................................................................. 158, 164 

End manual run .................................................................................................................................................................. 22, 51 

End Run ................................................................................................................................................................................. 22, 51 

Enhancement ......................................................................................................................................................................... 137 

Evaluation Variables ............................................................................................................................................................ 139 

Export Curves ......................................................................................................................................................................... 182 
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InjectAndRecover ................................................................................................................................................................. 138 

K 

ka ………………………………………………………………………………………………………………………………………54, 55, 73, 75, 77, 85, 93, 

116, 118, 120 

kd ………………………………………………………………………………………………………………………………………54, 55, 73, 75, 77, 85, 93, 
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Kinetics Summary ................................................................................................................................................................... 85 

Kinetics/Affinity .......................................................................................................................................................53, 57, 139 
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Low Sample consumption .......................................................................................................................................... 99, 136 

M 

Manual run ........................................................................................................................................................................... 14, 15 

Method Variables .................................................................................................................................................................. 139 

Methods ....................................................................................................................................................................................... 14 
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Mix with ..................................................................................................................................................................................... 137 

Multiple Rmax ............................................................................................................................................................................ 83 
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Normalize ............................................................................................................................. 29, 37, 61, 103, 147, 162, 179 

Number of cycles ..................................................................................................................................................................... 59 
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On-Off Rate Map ...................................................................................................................................................................... 86 

Overview ............................................................................................................................................................................ 94, 126 
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Predip ......................................................................................................................................................................................... 137 

Prime ............................................................................................................. 9, 29, 37, 61, 103, 147, 153, 154, 157, 163 
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Quality Control ................................................................................................................................................................ 73, 116 
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Rack tray .................................................................................................................................... 12, 13, 30, 38, 64, 106, 148 

Reagent rack, Type 1 .............................................................................................................................................................. 12 

Reagent rack, Type 2 .............................................................................................................................................................. 12 
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■総合お問合せ窓口 
 

TEL : 03-5331-9336 
 

● 機器アフターサービス 
（営業日の 9:00～17:30、音声案内に従い①を選択） 

FAX : 03-5331-9324（常時受付） 

● 製品技術情報に関して 
（バイオダイレクトライン、営業日の 9:00～12:00、13:00～17:30） 

音声案内に従い②を選択後、対象の製品別の番号を押してください。 

❶：ÄKTA、クロマトグラフィー関連製品 

❷：ビアコア関連製品 

❸：電気泳動関連製品、画像解析装置 

❹：IN Cell Analyzer、ワットマン製品、その他製品 

e-mail : Tech-JP@cytiva.com（常時受付） 

● 納期／在庫お問合せ 
（営業日の 9:00～12:00、13:00～17:30、音声案内に従い③を選択） 

 

注）お問合せに際してお客さまよりいただいた情報は、お客さまへの回答、弊社サービスの向上、

弊社からのご連絡のために利用させていただく場合があります。 

注）アナログ回線等で番号選択ができない場合はそのままお待ちください。オペレーターにつな

がります。 

 

www.cytivalifesciences.co.jp 
 

論文に掲載いただく際の名称・所在地 

Cytiva 
Tokyo, Japan 
 

グローバルライフサイエンステクノロジーズ      

ジャパン株式会社 

〒169-0073 

東京都新宿区百人町 3-25-1 サンケンビルヂン

グ 

お問合せ：バイオダイレクトライン 

TEL : 03-5331-9336 
e-mail : Tech-JP@cytiva.com 

掲載されている内容は 2019年 4月現在のもので予

告なく変更される場合がありますのであらかじめ

ご了承ください。掲載されている社名や製品名は、

各社の商標または登録商標です。お問い合わせに

際してお客さまよりいただいた情報は、お客さま

への回答、弊社サービスの向上、弊社からのご連

絡のために利用させていただく場合があります。 

 


